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2. Introduction 

 

 This document explains how to run My Schedule on a dedicated server and 

how to set up license authentication. 

 

 

 

3.Install My Schedule on a dedicated server! 

 

3.1 Download the WS control panel! 
 

 The latest version of Asprova comes bundled with My Schedule and can be 

started from the Start menu, but this section explains the procedure for 

installing My Schedule on a server machine or another machine where Asprova 

is not installed. 

 

 To begin, download the latest My Schedule module to your server machine. 

 

Q_01: I would like to know the recommended operating environment...▼ 

 
 

Step 3.1_01: Download the My Schedule module!　　 

  
 Download the Asprova My Schedule module from the official download page. 
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A ZIP file will be downloaded, so please extract (or unzip) it. 

 

 

Contents of Asprova My Schedule module folder 

 
 

Step 3.1_02: Run MySchedule.exe!　       

  
 "MySchedule.exe" in the extracted folder allows you 

to start and stop My Schedule and configure various 

settings. 

 Run "MySchedule.exe". 

 

Note: To configure the license authentication settings 

later, run the program with administrator privileges. It is 

not necessary to execute it with administrator authority 

when changing settings or in daily operation. 

 

 Run MySchedule.exe to open the WS control panel. 

 

 Asprova WS is a system that runs on a server, 

connecting Asprova with My Schedule and packaged 

products. 
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Step 3.1_03: Start WS!             

  
 Start WS by clicking the [▶ Launch] button at the top of the window. 

 

 

 

Note: When you click Start, a Windows Security dialog may pop up indicating that 

the firewall is blocking “Node.js JavaScript Runtime. ”  

Select Allow access to let it through the firewall. 

 

 

 When WS starts, the background color of the button turns green and the 

button changes to [■Stop]. 

 

 The log also describes and confirms that WS is up and running. 

 

 

Asprova My Schedule is running 

 

 

 The WS control panel must remain activated while using My Schedule. 
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3.2 Let's set up WS! 
 

 Various settings can be configured in the WS control panel. 

 Let us check the contents of the [Settings] tab. 

 
 

Step 3.2_01: Set up My Schedule          

  

 

Contents of the [Settings] tab screen 

 

-Host (IP) 

 

 In the Host (IP) field, enter the hostname or IP address. 

 

 When you first open the WS control panel, the Host (IP) field displays 

“http://127.0.0.1”. 

 

 This is a special IP address—called localhost—that always refers to the 

computer you’re currently using. 
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 If you are running My Schedule on a dedicated server, please enter the host 

name or IP address uniquely assigned to the server. 

 

 

-Port number 

 

 The default setting of "80" is fine, but if you cannot connect, set a value 

other than 80, such as 5001. 

 

 

-Advanced Settings 

 

-Delete past data 

 

 Deletes data (actual quantities and equipment capacity values entered in My 

Schedule) before the specified number of days among the data managed in My 

Schedule. 

 

 

-Start as a Windows Service 

 

 If turned on, My Schedule will also start automatically when the server starts. 

 

 

-Enable HTTPS 

 

 Name the SSL private key "privatekey.pem" and the certificate "cert.pem". 

 

 Place the above two files in the AsprovaWS/ssl folder in the hierarchy where 

MySchedule.exe downloaded in step 3.1_01 is located, and set the toggle 

switch to ON. 

 

 If you do not have an SSL folder, create one. 

 

 

-Password for the admin account 

 

 You can change the password for the admin account. 

 After completing the settings, access My Schedule from a web browser. 

 

 Launch your web browser and connect to My Schedule. 

 

 The combination of the host (IP) and port number listed in the [Settings] tab 

of the WS control panel is the address to connect to My Schedule. 
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 If you want to use the e-protector for license authentication, you need to 

install the driver for the e-protector. 

 

 The driver is installed in the [Licensing] tab of the WS control panel, so install 

it if necessary. 

 

 

Step 3.2_02: Install the e-protector driver!             

  
 Display the License tab of the WS control panel and press the "Install" button 

in the 

Driver Installation item to start the e-Protector driver installation. 

 

 

 

 

 Once the installation is performed, a progress window will appear. 

 The installation is then complete when the following window appears. 

 

 

 

 

 After making or changing settings in the WS control panel, the control panel 

must be restarted. 

 

 Exit and re-launch the Control Panel, then access My Schedule with a web 

browser. 
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Step 3.2_03: Connect to My Schedule from a web browser!           

      
 Enter the string of characters in the Host (IP) field and the numeric value in 

the Port Number field, which are set in the [Settings] tab of the WS control 

panel, connected by : (half-width colon), into your web browser and press 

Enter.     

 

             

 

Note: When accessing with the default address (http://1 27.0.0.1), please launch 

a web browser on the PC running WS control panel to access. 

 

 

 If the Asprova My Schedule login screen appears, the connection is 

successful. 

 

 

Asprova My Schedule Login Screen 

 

Q_02:The login screen of My Schedule does not appear in the web browser...▼ 

 

 

Step 3.2_04: Log in to My Schedule      

 

 When the login screen appears, try logging in with the admin account. 

Log in with the following user name and initial password. 
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Username admin 

Initial password *qkCMt4Ut5 

 

Note: In the Settings tab of the WS control panel, go to the very bottom and 

locate [Admin Account Password]. If you have already updated the password, 

enter the new one here. 

 

Q_03: I cannot log in to My Schedule from a web browser...▼ 

 

 

 Once logged in, you will see the items that can be configured under the admin 

account. 

 

Screen contents when logged in with the admin account 

 

 

3.3 Set up a license for My Schedule! 
 

 There are two methods of activating My Schedule: e-Protector and Online 

License. 

 

 The license setup is done on My Schedule, which is accessed from a web 

browser. 

Log in to My Schedule with an admin account in your web browser. 
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 Select [Server Settings] to view the current license status. 

If the license authentication method: None, only free plans are available. 

 

 

 

Server setting screen 

 

How to set up an online license...▼ 

 

 

- How to set up the e-protector 
 

 e-Protector is an authentication method that installs an electronic file 

(e-Protector) containing license information on the machine. 

 

 Obtaining an e-Protector requires an exchange of files between the server 

administrator and Asprova through the sales agent, and the process takes 

several days. 

 

 

 

 Select [e-Protector] from the license authentication method selection on the 

server configuration screen. 
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 If the window that appears when you press the [e-Protector] button displays 

the following red message, the e-Protector driver is not installed. 

 

 

 

 

 The driver can be installed in the WS control panel. 

Refer to "Step 3.2_02" to install the e-protector driver. 

 

 After installing the e-Protector driver, a fingerprint file is generated and sent 

to Asprova through the distributor. 

 

 Fingerprint files can be obtained from My Schedule, which is accessed 

through a web browser. 

 
 

Step 3.3_01: Let's get/send fingerprint files!    

 

 Press the [Generate fingerprint] button in the window that appears when you 

press [e-Protector] from the selection of license authentication methods in 

the server settings section. 

 

 

 

 

 A fingerprint file with machine-specific information will be downloaded under 

the name "asfingerprintXXX.c2v". 
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 Please send this file to Asprova through your distributor. 

 

Asprova will issue an authorization file containing license information, so 

please receive it from your distributor. 

 

 

Step 3.3_02: Let's read certification file     

 

 Press the [Apply licence file] button to set up the authentication file. 

 

 

 

 

 Press the [Apply licence file] button, and a window will appear to select the 

file. 

 

Press the [Choose File] button and select the certification file named 

"aslicenseXXX.v2c" (where XXX is the serial number string). 

 

 

 

 

 After selecting the file, press the [Apply] button to apply the certification file. 

 

 When the successful authentication dialog appears, the e-Protector license 
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authentication setup is complete. 

 

 Information such as available plans, number of simultaneous connections, and 

expiration date can be viewed on the server settings screen. 

 

 

 

 

 Finally, when the authorized certification file is applied, an e-protector 

creation log file "ascreatelogXXX.c2v" (where XXX is a string of serial 

numbers) will be downloaded. Please send this file to Asprova through your 

distributor. 

 

 

The e-protector creation log file being downloaded 

 
 

- Update e-protector Certification Information 
 

 Asprova My Schedule is a one-year contract and can be continued by 

updating the e-Protector authentication information when the contract is 

renewed. 

 

 Set the Magic No. that you receive from Asprova through your distributor at 

the time of contract renewal in My Schedule. 

 

 Magic No. Settings are made on the Server Settings screen. 
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Step 3.3_03: Update e-Protector authentication information with 

Magic No. 

 

 Press the [Manage License Information] button in the upper right corner of 

the license information. 

 

 In the window that appears when you press the [Manage License Information] 

button, there is a [Enter Magic Number] button. 

 

 

 

 

 Click on the [Enter Magic Number] button, enter the magic number you 

received in the input box of the window that appears, and then click on the 

[Apply] button. 

 

 

 

 

 When you press the [OK] button in the lower right corner of the Manage 

License Activation window to close the window, you will see information about 

the currently applied license. 
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 Under the License Term section, confirm that the term has been extended. 

 

 

- Preparation of a backup version of e-Protector 
 

Note: The backup version of e-Protector is available for My Schedule 

Ver. 25.2 or　later. 

 

 Since e-Protector is an authentication method that licenses a single machine, 

My Schedule will not be available in the event of trouble, such as the failure of 

a machine that is being authenticated with e-Protector. 

 

 In case of such problems, a backup version of the e-Protector is available in 

addition to the official version of the e-Protector. 

 

 Please prepare a different machine as a backup environment from the 

machine that uses the official version of e-Protector. 

 

 Machines in the backup environment must be configured for e-protectors in 

the same way as machines in the formal environment. 

 

 Follow the steps below to configure the e-protector settings for your backup 

environment. 

 
 

Step 3.3_04: Request a backup license file     

 

1.​  Download the Asprova My Schedule module from the official download 

page.(Refer to ： Step 3.1_01） 

 

2.​ Please run “MySchedule.exe” located in the downloaded folder with 

administrator privileges. (Refer to ： Step 3.1_02） 
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3.​ Display the [Settings] tab in the WS 

control panel, then click the [Install] 

button under the e-Protector section 

to begin installing the e-Protector 

driver. (Refer to ： Step 3.2_02） 

 

 

 

 

 

 

 

 

 

 

4.​ Access My Schedule with administrator privileges and select the [Server 

Settings] tab. 

 

 

 

 

5.​ Select [e-Protector] button in the window that appears. 

 

 

 

 

6.​ Click the [Generate fingerprint] button to obtain the fingerprint file. 

(Refer to ： Step 3.3_01) 
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7.​ Contact us to request a backup license file. 

 

In your message, please include: 

 - The purpose of using the backup e-Protector. 

 - The fingerprint file (example: asfingerprintXXXX.v2c) generated from 

your PC. 

 

 Wait for us to send back your backup license file. 

 
 

Step 3.3_05: Obtain and prepare the backup license file   　　 

 

1.​ Once you receive the backup license file (example: 

aslicenseXXXX_backup.v2c), save it to a known location on your PC. 

 

2.​ Start My Schedule. 

Log in using a Server Admin account. 

 

3.​ Go to the “Server Settings” tab. 

 

4.​ Open the “e-Protector” menu from the available options. 

 

5.​ Click the button labeled [Apply backup license file] 
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6.​ Attach your backup license file (aslicenseXXXX_backup.v2c). 

 

7.​ Click “Apply” 

 

Once registered, the backup license can be activated at any time. 

 

Important Note: 

 

 After registration, My Schedule can be used without limitations for 3 

weeks from the time of activation.   

 

 Only proceed to the next step when you are ready to begin the backup 

license period. 

 

 

Step 3.3_06：Activate the backup license 　　 

 

1.​ Open the License Information section. 

 

2.​ In the license information dialog, select: “Activate the backup license” 

 

 

 

 

3.​ Click the Confirm button to start the backup license period. 

 

Extending or resetting the backup license 

 

Please contact us if you need to: 

- Extend the duration of your backup license, or   

- Reset the backup license to its pre-activation state (to allow reactivation 

later), 

 

 Backup license extensions and resets are processed using magic numbers, 

the same method used for regular licenses. 
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Q_04: I want to move my e-protector to another machine...▼ 

Q_05: I want to use e-protector with virtual machine technology...▼ 

How to set up e-protector...▼ 

 

 

-How to set up an online license 
 

Step 3.3_04: Set up online license activation!　 

 

 Press the [Online] button from the Authentication Method selection on the 

Server Setup screen to configure the settings. 

 

 

 

 

A pop-up window will appear. Log in with your Asprova ID. 

Search for available licenses assigned to your Asprova ID. 

 

 

 

 

 When the list of available licenses appears, click the [Select] button next to 

the license you want to use. 

 

 Sometimes the [Select] button is disabled, and a (?) icon appears in its place. 

 

 Hover the mouse pointer over the (?) icon and the reason the button is 

disabled will appear, as shown in the figure below. 
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 After selecting the serial number to be used for the online license, 

information such as available plans, number of projects, number of 

simultaneous connections, and license expiration date will be displayed, and 

My Schedule will be available with the license you have selected. 

 

 

 

 

 The [Manage License Information] button in the upper right corner of the 

license information displays the "Manage License Activation" pop-up window, 

which allows you to cancel the currently selected license or change the 

licensing method. 
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 The "Change" button allows you to choose whether the activation method will 

be e-protector or an online license. 

 

 

 

 

 Pressing the [Logout] button will deactivate the online license serial if you 

have not set up an e-protector, and you will be able to use only the free plan 

to which the license has not been applied. 

 

 

-Online license renewal 
 

 Asprova My Schedule is a one-year contract and can be continued by 

renewing the contract. 

 

 After renewing your subscription, you do not need to renew it in My Schedule, 

which you access through a web browser, or in the WS control panel. 

 

 Check the My License page to confirm that the expiration date has been 

extended. 

 

 

 

4. Set up a My Schedule project from your web 

browser 

 

 To configure projects, log in to My Schedule with the admin account. 

If you don't have any projects yet, add one. 

 

 

Step 4_01: Add a project!    
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 You may add projects via Project Management. 

Click the [Project Management] button to open the Project Management 

screen. 

 

 

Project Management Screen 

 

 

 Click the [+Add Project] button to add a project. 

 

 Fill in the project summary in the window that appears and select the plan 

you want to apply to the project from "Plan". 

 

 

Project Plan Selection Screen 

 

 

 Clicking the [Create] button will close the pop-up window, and the created 

project will appear in the list. 

 

 

A view of the project being added 

 

21 



 

 Click on the project name of the project you created to see the project. 

 

In a newly created project, you will see the message "No screens have been 

set up for this project." is displayed. 

 

 Press the [Project Settings] button to configure the project contents. 

 

 

 
 

Step 4_02: Let's set up the project details    

 

 In the advanced project settings, the following items can be configured 

 

-Basic Information 

 Basic project information can be edited and reviewed. 

 

-Screen Settings 

 Select the screens to be shared in the project. 

 

-User Settings 

 You can set users and permissions to share projects. 

 

 Here we will proceed with an example of adding a [Resource Gantt Chart"]in 

the "Screen Settings" section. 

 

 Make sure the screen you want to share has a check mark and press the 

[Save] button. 
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 Let's go back to the previous screen by pressing the [◀︎ Back] button in the 

upper left corner of the window, and click on the icon of the added screen. 

 

 If the message "Required file not found" appears, the schedule data has not 

yet been uploaded. 

 

 Upload your scheduling data from Asprova. 

 

 

 

5. Let's link Asprova and My Schedule! 

 

5.1 Prepare to use My Schedule with Asprova! 
 

 Let's set up Asprova to upload data from Asprova to My Schedule. 

 

In order to link with My Schedule, such as uploading scheduling data from 

Asprova and downloading actuals, the My Schedule plug-in must be installed 

in Asprova. 

 

 

Step 5.1_01: Let's install plug-ins to Asprova!     

 
 The My Schedule module folder downloaded in step 3.1_01 contains a plug-in 

for Asprova. 

 

If Asprova is running, exit it once. 

 

 There is a file named AsMySchedule.dll in the "Plugin" folder > "bits" folder in 

the 

"My Schedule module" folder. 

 

 Copy this file to the same hierarchy as Asprova.exe. 
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 The number of bits in the plug-in must be aligned with the number 

of bits in Asprova. 

 

 The version of Asprova can be checked on the title bar. 

 

 If [64bit] is not displayed, the version is 32bit. 

 

 

 

Example of display in the upper left corner of the Asprova window 

 

Note: If your copy of Asprova isn’t the latest, upgrade it to version 17.6.0.0 or 

later -those are the earliest releases that work with My Schedule. 

 

 After installing the plug-in file, launch Asprova with administrative privileges. 

 
 

 

Step 5.1_02: Let's set up the Asprova side. 

 
Execute the "Plug-in Information" menu from the 

"Help" menu on the toolbar. 
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In the "Plug-in Information" menu, check 

"AsMySchedule.dll" on the left side. 

Press "OK" to return to the original screen. 

 

 

 

 

 

 

If the menu item "Asprova My Schedule Linkage 

Settings" is added to "Tools" in the menu bar, the 

Asprova My Schedule linkage plug-in has been added 

successfully. 

 

 

 

 

Note: If "AsMySchedule.dll" is not found on the left 

side of the "Plug-in Information" menu: Make sure the plug-in file 

(AsMySchedule.dll) is in the same directory as the Asprova main unit. 

 

 

5.2 Set up the integration! 
 

 With My Schedule activated in the WS control panel, open the project to be 

uploaded to My Schedule in Asprova and follow the steps below. 

 

 

Step 5.2_01: Let's set up the Asprova side. 

 

Select [Asprova My Schedule Settings] from the 

[Tools] menu bar in Asprova. 

 

 

 

 

 

 

Q_06: Asprova My Schedule operation items are not displayed...▼ 
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Asprova My Schedule Linkage Setting Window 

 

 In the Asprova My Schedule Linkage Settings window, enter the settings you 

have just made in the WS control panel in the "Connection destination server 

settings" field. 

 

 If you want to connect using HTTPS, check the [Always trust SSL certificate] 

checkbox next to the Host/IP address input field. 

 

Host Name/IP Address http://127.0.0.1:80 

Username admin 

Password *qkCMt4Ut5 

 

Note: If you have changed the host/IP address, port number, or password, please 

enter the changed information. 

 

 After you enter the information above, click [Connect and Retrieve Project 

Name], following which a message reading “Connected successfully” will 

appear. 

 

Q_07:I cannot connect to Asprova My Schedule in the linked settings...▼ 

 

 Select the name of the project you wish to upload from the Project Name 

pull-down list in the "Connect to Server Settings" section. 
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Destination Server Settings 

 

Q_08: Why am I seeing the Free plan even though I purchased the Standard (Viewer) 

plan? ▼ 

 

 Under "Display Period," you can set which periods of data will be sent to the 

Asprova My Schedule backend. 

 

 

Display Period Setting 

 

 

 There are two ways to choose the display period. 

 

1.​ Dynamically specified 

Select one of "Assigned Start Time", "Display Start Time", and 

"Scheduling Basic Time" from the combo box on the left side, and then 

enter the number of days in the text box on the right side. 

 

 

 

 

 

 See below for the definition of the display period. 
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Screen Definition of Display Period 

Resource Gantt 

Chart 

Start and finish date and time of operation 

Order Gantt Chart Start date and time of the earliest operation 

in the order, and end date and time of the 

latest operation in the order 

Manufacturing BOM (Not applicable) 

Operation table Start and finish date and time of operation 

Dispatching View Start and finish date and time of operation 

Order Lead Time Start date and time of the earliest operation 

in the order, and end date and time of the 

latest operation in the order 

 

 For example, if the display period is set to "January 1, 2024~June 1, 2024," 

the resource Gantt chart will upload data for operations whose start and end 

dates and times are from January 1, 2024, to June 1, 2024. 

 

 

2.​ Specify a fixed date 

How to specify a period using start/end dates, regardless of the 

allocation start date and time 

 

 

 

 

 For the Standard and Viewer plans, the display period is unlimited and can be 

freely specified. 

 

 For the Free Plan, the maximum display period is 14 days. 

 

Note: Even in the case of unlimited, the display period must be set. 

 

 Under "Screen Selection," select the screen you wish to upload. 

 

 Select the screen you have just selected in the My Schedule screen settings 

here as well. 
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Screen Selection 

 

Q_09: The screen I want to upload is grayed out, and I can't select it...▼ 

 

 

 Clicking on the icon for each screen opens a window to select which style to 

upload. 

 

Select the style you wish to upload and press the [Add>>] button. 

 

 For Standard and Viewer plans, you can select multiple styles. 

 

 For the Free Plan, only one style can be selected. 

 

 

Style Selection 

 

 Once the settings have been made, press the [OK] button to close the 

Asprova My Schedule Linkage Settings window. 

 

 

Step 5.2_01: Let's set up the Asprova side. 

 

Reschedule and with the operation assigned, 

select [Asprova My Schedule ▶ ] > [Data Upload] 

from [File] on the menu bar to upload the data. 
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Note: Uploading requires project administrator or server administrator privileges.  

Browse and enter results Uploading is not allowed for accounts with 

"Permissions" or "View Only" privileges. 

 

 

Step 5.2_03: View the uploaded schedule data in a web browser 

 

 Go back to your web browser and look at the scheduling data. 

 

 Click on the screen icon of the project you have added. 

 

 

 

Q_10: I get an error message about the number of simultaneous connections and 

cannot view the schedule…▼ 

 

 

Resource Gantt chart displayed in My Schedule 

 

 We could see a Gantt chart in the same style as the uploaded scheduling 

data. 

 

Q_11: The selected style is not displayed...▼ 
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5.3 Download Achievements! 
 

 In the Standard and Free plans, you can enter actual results from My 

Schedule. 

 

Let's input the results tentatively and download them in Asprova. 

 

 Please select one of the tasks on the resource Gantt chart that you are 

viewing in your web browser. 

 

 The selected operation will be highlighted in the timeline display on the right 

side of the window, and the Enter Results button will appear. 

 

 In this procedure, we will use the example of pressing the [Edit Results] 

button to enter results. 

 

 

Step 5.3_01: Let's enter Achievements 

 

 Select an operation on the resource Gantt chart and press the [Edit result] 

button in the Timeline view. 

 

 In the Edit Results window, select [Completed] from the Status item and 

press the [OK] button. 

 

 

 

 

 If the operation bar with the results entered has a shaded line, the results 

have been entered. 
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The shaded line on the bar where results are entered 

 

 

Step 5.3_02: Download the results! 

 

 Let's download the results entered in My Schedule in Asprova. 

 

 Select [Asprova My Schedule] from [File] in the menu bar of Asprova, Please 

execute "Download Data". 

 

 

 

Note: Downloads are available with the Free and Standard plans. They are not 

available under the Viewer plan. 

 

Q_06: Asprova My Schedule operation items are not displayed...▼ 

 

 

 When an actual result is downloaded, Asprova's resource Gantt chart also 

shows a shaded line in the target work bar to indicate that the result has been 

entered. 

 

 

Asprova reflects the results 
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​​6. Share your scheduling data with My schedule! 

 

 Share your prepared project with other users. 

 

 To share scheduling data with other users, add users and invite them to your 

project. 

 

 Follow the steps below to add and invite users. 

 

 

6.1　Let’s create new users! 

 

 

Step 6.1_01: Let's add a user! 

 

 Log in to My Schedule from a web browser with an admin account and add 

users. 

 

Click the [User Management] button to switch to the User Management 

screen. 

 

 The account that appears in the list as "admin (server administrator)" is your 

account. 

 

 Let's add a user by pressing the [+Create a user] button. 

 

 Here we create “test_user_001” as an example. Set the password accordingly. 

 

 

 

*Refer to this section for Active Directory users 
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Step 6.1_02: Invite users! 

 

 Invite the added users to the project you have created. 

 

 Select the project from the list to which you want to invite users. 

 

 Users can be invited in the [User Settings of the Project], which is displayed 

by pressing the "Advanced Settings of the Project" button. 

 

-Invite users 

 

 

 

There are two ways to invite users. 

 

-​ Invite existing users 

You can search for added users on the User Management screen to set 

permissions and invite 

them. 

 

-​ Invite new users 

Users who have not yet registered can be invited directly. 
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 Let's invite the user "test_user_001" who was just registered on the user 

management screen. 

 

 Enter letters such as [test] and click the [Search] button, and candidates will 

appear in the list. 

 

 Select the users to be invited from the list, set the permissions, and click the 

"Add" button to invite them to the project. 

 

 Let's also look at how to invite new users. 

Select the permissions and press the [Create Invitation] button. 

 

 

 

 

 Copy the message and send it to the user you want to share it with by e-mail 

or other means. 

 

 Invited users can register themselves when they access My Schedule via the 

link provided in the message. 

 

 Users can be invited, and permissions can be set for each project. 

 

 When uploading multiple projects, please invite users for each project. 

 

 If the Invite Users window displays the following message, the uploaded 

project is inaccessible to other users. 

 

 Set up a dedicated server for My Schedule, then follow the instructions in 

Chapter “3, Install My Schedule on a Dedicated Server,” to complete the 

configuration. 
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-Invite restricted users 

 

 

 

　Restricted users are users who are granted access only to specific data and 

screens within the project they are invited to. 

 

 To use this feature, you must upload the data for the split view to the project. 

 

 Restricted users can be invited from both 

registered users and new users. 

 

Here, we'll look at how to [invite registered 

users]. 

 

　Select [Invite registered Users] and click 

the [Next] button to display a list of 

registered users. 

 

Select the users you wish to invite from the 

list and click the [Next] button. 

 

 

 

　You can set whether viewing and editing 

achievements is allowed for each resource. 
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6.2　Set up user authentication using Active 

Directory! 

 

　Asprova My Schedule supports Active Directory integration for user 

management and login authentication. 

 

Step 6.2_01：Set up the Active Directory connection settings!　　　　　　　　 

 

　Log in to My Schedule via a web browser using an admin account. Click the 

[Configure Users] button, then click the [Active Directory Settings] button 

found at the bottom of the User Management screen. 

 

 

 

　When the [Active Directory Settings] dialog opens, input the Active Directory 

URL, Base DN, Username, and Password. 
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　Username and Password are required fields. 

The user information entered here is used to verify the existence of Active 

Directory users during the next registration step. 

 

For the Username and Password, please enter the credentials of an Active 

Directory user that exists under the Base DN. Click the [Save] button to 

complete the configuration. 

 

 

Step 6.2_02：Register Active Directory users to My Schedule!　　　　　　　　 

 

　Click the [+ Create a user] button on the User Management screen to open 

the dialog for creating a new user. 

 

 

 

 

　Once the Active Directory connection is configured, the [○ Active Directory 

User] button will become available for selection.  

　Enter the username of the Active Directory user and click the [Create] 

button. 
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　The username must exactly match the UserPrincipalName registered in Active 

Directory. However, when the created user logs in, they may also use their 

sAMAccountName. 

 

　When 'Check if user exists in Active Directory' is turned ON, an error message 

will be displayed and the creation will fail if the user does not exist at the time 

of registration. If turned OFF, this validation check is skipped. 

 

-​ How to verify usernames registered in Active Directory: 

 

　　Open 'Active Directory Users and 

Computers' from Server Manager, 

right-click the relevant user, and select 

[Properties]. 

 

 

 

 

　　The combination of the displayed 

'User logon name' and the domain name 

is the username to be entered during 

setup. 
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　Once created successfully, the 

username will appear in the user list 

with an 'Active Directory' label. 

 

 

 

 

 

　On the web application's login page, enter the Active Directory username of 

the account you created and the corresponding Active Directory password, 

then click [Active Directory Login] to log in. 

 

 

 

*If the Active Directory connection settings have not been completed,  

the [Active Directory Login] button will not be displayed. 

 

 

 

7. Update your My Schedule to the latest version! 

 

 The Asprova My Schedule module is updated once or twice a month and the 

updates can be found at New Features page. 

 

 In order to take advantage of the newly added features and receive bug fixes, 

the My 

Schedule module must be updated to the latest version. 

 

 Updating the Asprova My Schedule module does not lose the project settings 

and user settings stored on the server. 

 

 Find out how to update your information below. 

40 

https://www.asprova.jp/products/myschedule/10855.html


 

Step 7_01 Update My Schedule module 

 

 

 To update the My Schedule module, 

use the [Check for Updates] button in 

the Control Panel. 

 

 An internet connection is required to 

perform online updates. 

  If My Schedule is running, it must be 

closed once. 

 

Press the [Check for Updates] button 

at the bottom of the control panel to 

display the update dialog. 

 

Press [Get Version Information] in the 

dialog to get the latest version 

information. 

 

If a newer version is found, enter your 

AsprovaID and password, and press the 

[Update] button to automatically 

update. 

 

 

 

 

Step 7_02 Update the plugin 

 

 After updating the My Schedule module, the next step is to update the My 

Schedule plug-in (AsMySchedule.dll) that Asprova is loading. 

 

 If Asprova is running, it must be closed once. 

 

Navigate to: 

   C:\ProgramData\Asprova\Asprova My Schedule\release\Plugin\64Bit 

 

This folder contains the 64-bit plugin file needed for Asprova. 

 

 Note: that the number of bits in the plug-in must be aligned with the number of 

bits in Asprova. 
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 Inside the “64Bit” folder, find the file named : AsMySchedule.dll 

Right-click it and select “Copy.” 

 

 Open the following folder: 

    C:\Program Files\Asprova Corporation\Asprova 

 

 Right-click inside the folder and select “Paste.” 

 If asked to overwrite, select “Replace the file in the destination.” 

 

 

 

Step 7_03 Re-upload data 

 

 Updates may require re-uploading data from Asprova. 

 

 If you need to re-upload your data, you will see the following on My Schedule. 

 

 

 

 

 If you get the above message, please re-upload with a newer version of the 

plug-in. 

 

Q_12: The old version is displayed in the web browser even after updating...▼ 

 

8.Manually updating the My Schedule Module 

(Troubleshooting Guide) 

 

 This guide is intended for users who are using a very old version of My 

Schedule, or who are having trouble using the automatic updater in the control 

panel. 

 

 If you encounter errors or the update does not complete automatically, 

please follow the steps below to manually update the My Schedule module. 
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Step 8_01 Download the My Schedule module! 

 

 Download the Asprova My Schedule module from the official download page. 

 

 Log in with your Asprova member account if required. 

 

Find “My Schedule モジュール (My Schedule module)” in the list and download 

the latest version. (Refer to ： Step 3.1_01) 

 

 

 

 

 A ZIP file will be downloaded, so please extract (or unzip) it. 

 

 You will see several folders and files inside — these will replace your old 

version. 

 

 

 

 

Step 8_02 Delete the existing Asprova WS version folder 

 

 Open File Explorer on your PC. 

 

 In the address bar, copy and paste the following path, then press Enter: 

   C:\ProgramData\Asprova\Asprova My Schedule\release 

 

 The “release” folder will open. This folder contains the currently installed 

version of My Schedule. 
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 Inside the “release” folder, locate the “Asprova WS” folder 

Right-click that folder and select “Delete.” 

 

 This step removes the old My Schedule files before placing the new version. 

 

 

 

 

Step 8_03 Copy the new files into the release folder 

 

Select all files and folders from inside the opened Zip archive. 

 

Go back to the following folder: 

   C:\ProgramData\Asprova\Asprova My Schedule\release 

 

Paste (Ctrl + V) and choose “Replace the files in the destination” when 

prompted. 
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9. Q & A 

 

 

Q_01: I would like to know the recommended operating environment. 

 

A_01: 

Hardware Operating environment 

PC data server 

 

dedicated to data 

sharing 

 

64-bit version of Windows with valid support 

●​ Windows 10 22R2 

●​ Windows 11 

●​ Windows Server 2016 or later 

 

Required specs 

●​ CPU: 2 cores or more (does not work with 

ARM) 

●​ Memory: 4GB or more 

●​ HDD: 300MB or more 

Terminal to view the 

schedule (PC/tablet, 

etc.) 

The latest version of Chrome is recommended, but 

other web browsers can be used to view the site 

with little or no problems. 

 

 

 

Q_02: The My Schedule login screen does not appear in my web browser 

 

A_02: 

 If the port number you set is in use by another application, you will not be 

able to connect. 

 

 Please change the port number to a number other than 80, such as 5001, and 

stop and start My schedule again, then change the port number entered into 

the web browser and access it again. 

 

 If you still cannot connect, please check the following 

 

1.​ Make sure the WS control panel is open and that My Schedule itself is 

running. 

 

2.​ Please check if you are connected to the same address as the Host (IP): 

Port number in the [Settings] tab of the WS control panel. 

 

3.​ To find out why you cannot 

connect, start a command 

prompt, type "ping" and the 
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IP address or URL of the connection destination, and press the Enter 

key. 

 

(If there is a response) 

Network connection is established 

to the server. Please check again 

that the 

username and password you 

entered are correct. It is also 

possible that the firewall is 

blocking only the port number that 

you have set, although the ping 

passes. Please try changing the 

port number and see if you can 

connect. 

 

(If there is no response) 

The server cannot be accessed, 

please check your network and 

firewall settings. 

Also, open the Plug-in Information 

window by clicking [Help]>[Plug-in 

Information] on the menu bar of 

Asprova, and if "AsMySchedule.dll" 

is not listed in the module 

name list, check that the plug-in 

file (AsMySchedule.dll) is in the 

same directory as Asprova itself. 

 

4.​ Make sure the port number is not in conflict with another application 

and free the port in your firewall configuration. 

 

Below is a description of the 

setup procedure for a Windows 

PC. 

 

Open [Control Panel] > [System 

and Security] > Open [Windows 

Defender Firewall], then choose 

[Advanced settings]. 
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The Advanced Firewall Settings 

screen will open, and from the 

"Programs" section, 

locate "AsprovaWS.exe". 

 

 

Right-click on the 

"AsprovaWS.exe" line and select 

[Properties] from the menu that 

appears. 

 

 

 

 

 

 

 

In the Properties window, open 

the [Protocol and Ports] tab. 

Under [Local port], either select 

[All Ports] or choose [Specific 

Ports] and enter the port number. 

 

Please configure the settings as 

shown above and release the 

Asprova My Schedule port. 

 

 

 

 

 

 

 

 

 

Q_03: I cannot log in to My Schedule from a web browser. 

 

A_03: 

1.​ Please make sure you have the correct username and password. 

2.​ If you have changed your password from the initial password, please 

enter the new password. 

3.​ If you do not know the password for the admin account, enter a new 

password in the "Password for admin account" field under the [Settings] 

tab in the WS control panel and press the [Update] button. 
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Q_04: I want to move my e-protector to another machine 

 

A_04: 

If you’re replacing your PC or otherwise switching to a different computer, 

complete the following steps in order: 

 

❶ Activate (formally authorize) the new PC you will use. 

❷ Cancel the authorization on the PC you are currently using. 

❸ Extend the usage period for the new PC. 

 

❶ Activate (formally authorize) the new PC you will use 

          Refer to "Step 3.2_02" to install the e-protector driver. 

          Refer to "Step 3.3_01" to export the fingerprint file and send it to  

          Asprova through your distributor. 

          Refer to "Step 3.3_02" to read the certification file. 

                    When the certification file is loaded, a file named  

                    "ascleatelogXXX.c2v" (where XXX is the serial number string) 

                    will be downloaded, so please send this file to Asprova through  

                    your distributor. 

 

❷ Cancel the authorization on the PC you are currently using 

1.​ Access My Schedule in a web browser with an admin account to view On 

the "Server Settings" screen, click the [Manage License Information] 

button. 

2.​ The "Manage License Activation" window will appear, and press the [Get 

e-Protector Creation Log File] button. 

3.​ A file named "ascreatelogXXX.c2v" will be downloaded. Please send this 

file to Asprova through your distributor. 

                   Based on the information received, Asprova will create a                      

                    cancellation file.     

                    It takes several days for the cancellation file to be sent. 
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4.​ After receiving the cancellation file, press the "Apply Cancellation File" 

button in the "Manage License Activation" window to load the 

cancellation file named "ascancelXXX.c2v". 

 

5.​ When the cancellation file is loaded, a file named "ascancellogXXX.c2v" 

will be downloaded. Please send this file to Asprova through your 

distributor. 

 

 

 

❸ Extend the usage period for the new PC 

                   A magic number will be issued to extend the period of use of the                     

                   new PC. Please refer to "Step 3.3_03" to enter the magic number. 

 

 The procedure numbers in the figure below correspond to the numbers in this 

instruction manual, so please check the operating instructions. 

 

 Various files output during the formal authentication and authentication 

cancellation operations need to be exchanged between Asprova through the 

distributor. 

 

 The process takes several days, so please plan accordingly. 
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Q_05: I want to use e-protector with virtual machine technology 

 

A_05: 

　Authentication is required for each virtual machine when using virtual 

machine technology. 

 

　The following virtual machine software and cloud services are supported. 

However, if you use a feature that changes the hardware information, it may 

be assumed that　you have changed to a different machine, and the 

e-protector will no longer be recognized. 

 

 VMWare Microsoft Xen 

Project 

4.12 

Amazon 

Web 

Service 

EC2 

Google 

Cloud 

Platfor

m 

Virtual 

Machin

es 

ESXi 

4.x, 5.x, 

6.x, 7.x 

Worksta

tion 

15, 16 

Hyper-V 

Server 

2008, 

2012, 

2016, 

2019, 

2022 

Azure 

Virtual 

Machin

es 
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Use of 

e-Protector 
○ ○ ○ ○ ○ ○ ○ 

If a virtual machine is modified using the following functions, the e-protector 

will not be recognized. (x: Combinations that cannot be used) 

Live migration × × ×  ×   

Hot stand-by × × × × × × × 

Virtual machine 

reproduction 

(Clone) 

× × × × × × × 

Restore from 

Snapshot 
× × × × × × × 

Change the 

instance 

and volume 

combination 

   ×  × × 

 

●​ Live migration: This refers to moving the entire OS and software running 

on one virtual　machine to another physical computer without stopping. 

This is also the functionality　of virtual machine monitors and other such 

devices. 

 

●​ Hot standby: A method of improving reliability by making equipment and 

systems　redundant. It refers to a method in which multiple systems are 

kept in operation at all　times, and when an error occurs in one system, 

the other　system immediately takes over 

processing. Similar methods include cold standby, which starts up from a 

standstill state　and takes over processing. 

 

●​ Virtual machine duplication (clone): refers to the ability to create a 

duplicate　of a virtual　machine at a specific point in time. In Amazon 

Web Services EC2, if　you create an　Amazon Machine Image (AMI) after 

e-protector authentication and then create a virtual　machine on another 

instance, the e-protector will not be recognized and you will need　to go 

through the authentication process again. The same applies to Azure. 

 

●​ Restore from Snapshot: refers to a file-based snapshot of a virtual 

machine's state,　disk data, and configuration at a specific point in time. 

 

●​ Changing the combination of virtual machine instances and volumes: 

This means　changing the combination of virtual machine instances and 

volumes in Amazon Web　Services EC2, Azure, etc. It is possible to 

change the instance type of a virtual　machine. 
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　In some cases, applications related to the e-Protector may be mistakenly 

controlled by the　DEP or anti-virus software, and the e-Protector may not be 

able to recognize them. In such a　case, please exclude the following files from 

the control target in your DEP or anti-virus　software and check the operation. 

C:\Windows\System32\hasplms.exe 

 

　The following service is required to recognize the protector. If you cannot 

find this service　in the service list of Sentinel LDK License Manager Windows, 

reinstall Asprova My Schedule. 

 

 

 

Q_06: Operation items in Asprova My Schedule are not displayed 

 

A_06: 

　If you are using the custom menu (the [Custom Menu] at the bottom of the 

[View] menu in　the menu bar is checked), the My Schedule-related menus will 

be hidden. 

 

In this case, either disable the custom menu or add My Schedule-related　

menus to your　custom menu by following the steps below. 

(Instructions for adding to the toolbar) 

　On the menu bar, click [Tools] > [Toolbars and Shortcut Keys] to open the　

"Customize"　dialog box, and drag and drop the My Schedule-related menu　

items to the desired location. 

 

 

 

 

 

Q_07: I cannot connect to the Asprova My Schedule linkage settings 

 

A_07: 

　Please make sure that the host (IP) and port number you entered in the　

Settings tab of the　WS control panel are the same for the My Schedule 

linkage settings. 
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Q_08:Why do I see a Free Plan even though I purchased a Standard (Viewer) 

Plan? 

 

A_08: 

　Even if you’re on the Standard or Viewer plan, you can still use the Free plan 

at the same time. 

 

You can use this service by selecting either the Free Plan or the Standard Plan

　(viewer plan)　for each project in the project settings of My Schedule, which 

is performed via a web browser. 

 

　If you have not set up license authentication, please follow the instructions　

in "3.3 Set up a license for My Schedule!". 

 

　If you are still unable to select a Standard or Viewer plan after setting up　

activation, please　check the following 

 

1.​ In the "Help" menu above Asprova, click "User Registration". From the 

list of optional　features on the right side of the pop-up window, please 

make sure that Asprova My　Schedule Linkage Option (Free Plan) and 

Asprova My Schedule Linkage Option　(Standard Plan) are checked. 

 

2.​ The option checkbox exists but is not checked. ⇒ Please check the box. 

 

3.​ The checkbox for the option exists and is checked. ⇒ Check 2. 

 

4.​ The checkbox for the option does not appear ⇒ You are most likely 

logged in　with a　different serial than the serial for which you purchased 

the My　Schedule linkage option. 

 

5.​ Log in to Asprova My Schedule as admin, check if the project is created 

with　the　Standard (Viewer) plan and change it if necessary. 

 

 

 

Q_09: The screen icon I want to upload is grayed out and I cannot select it 

 

A_09 

 Log in to Asprova My Schedule with the admin account and check to see if the 

screen icons used for the relevant project are checked. 

 

*Uploading requires project administrator or server admin privileges, and 
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cannot be performed with an account that allows viewing and results input, or 

with view-only privileges. If you wish to change the same, please log in to 

Asprova My Schedule with the above privileges before setting. 

 

 If you want to import the results, etc., entered in the web browser into 

Asprova, execute 

[File]>[Asprova My Schedule ▶]>[Download Data] from the Asprova menu bar. 

 

* Downloads are available for Free and Standard plans. It is not available for 

Viewer plans. 

 

 

 

Q_10: Cannot view the plan due to a concurrent connections error 

 

A_10: 

 The Free Plan has one simultaneous connection, so while you are viewing a 

plan in My Schedule on one terminal, you cannot view it on another terminal. 

 

 Please note that the number of simultaneous connections will be counted for 

each of you, even if you are viewing the plan with different web browsers on 

the same device. 

 

 In addition, the number of simultaneous connections will be occupied for 15 

minutes after the plan viewing is finished. 

 

 The count of concurrent connections is reset when you exit My Schedule via 

the control panel. 

 

 

 

Q_11: The selected style is not displayed 

 

A_11: 

 After preparing the display in Asprova's Gantt chart or table, please make 

sure to save the style. 

 

 To save a style, right-click in the upper left corner of a chart or table and 

select [Style Settings] > [New Style...] from the menu that appears. or "Save 

Style Overwrite..." from the menu that appears by right-clicking in the upper 

left corner of the chart or table. 
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Q_12: Even after updating, the web browser shows an old version 

 

A_12: 

 With My Schedule displayed in your web browser, hold down the [Ctrl] key on 

your keyboard and press the [F5] key. 

 

 If you still see an older version using the above methods, reset the cache in 

your web browser. 

 

 

 

Last update: 02/06/2026 

55 


	Asprova My Schedule Introduction Procedure 
	1. Table of Contents 
	2. Introduction 
	3.Install My Schedule on a dedicated server! 
	3.1 Download the WS control panel! 
	Q_01: I would like to know the recommended operating environment...▼ 

	 
	Step 3.1_01: Download the My Schedule module!　　 
	  
	 
	Contents of Asprova My Schedule module folder 


	 
	Step 3.1_02: Run MySchedule.exe!　       
	  
	Note: To configure the license authentication settings later, run the program with administrator privileges. It is not necessary to execute it with administrator authority when changing settings or in daily operation. 


	 
	Step 3.1_03: Start WS!             
	  
	Note: When you click Start, a Windows Security dialog may pop up indicating that the firewall is blocking “Node.js JavaScript Runtime. ”  
	Select Allow access to let it through the firewall. 
	Asprova My Schedule is running 


	3.2 Let's set up WS! 
	 
	Step 3.2_01: Set up My Schedule          
	  
	Contents of the [Settings] tab screen 

	Step 3.2_02: Install the e-protector driver!             
	  
	Step 3.2_03: Connect to My Schedule from a web browser!           
	      
	 
	Note: When accessing with the default address (http://1 27.0.0.1), please launch a web browser on the PC running WS control panel to access. 
	Asprova My Schedule Login Screen 
	Q_02:The login screen of My Schedule does not appear in the web browser...▼ 

	Step 3.2_04: Log in to My Schedule      
	Note: In the Settings tab of the WS control panel, go to the very bottom and locate [Admin Account Password]. If you have already updated the password, enter the new one here. 
	 
	Q_03: I cannot log in to My Schedule from a web browser...▼ 
	Screen contents when logged in with the admin account 


	3.3 Set up a license for My Schedule! 
	Server setting screen 
	How to set up an online license...▼ 

	- How to set up the e-protector 
	 
	Step 3.3_01: Let's get/send fingerprint files!    
	Step 3.3_02: Let's read certification file     
	 
	The e-protector creation log file being downloaded 


	 
	- Update e-protector Certification Information 
	Step 3.3_03: Update e-Protector authentication information with Magic No. 

	- Preparation of a backup version of e-Protector 
	Note: The backup version of e-Protector is available for My Schedule 
	Ver. 25.2 or　later. 

	 
	 
	 
	Q_04: I want to move my e-protector to another machine...▼ 
	Q_05: I want to use e-protector with virtual machine technology...▼ 
	How to set up e-protector...▼ 

	-How to set up an online license 
	-Online license renewal 

	4. Set up a My Schedule project from your web browser 
	 
	Step 4_01: Add a project!    
	Project Management Screen 
	Project Plan Selection Screen 
	A view of the project being added 

	 
	Step 4_02: Let's set up the project details    

	5. Let's link Asprova and My Schedule! 
	5.1 Prepare to use My Schedule with Asprova! 
	 
	Step 5.1_01: Let's install plug-ins to Asprova!     
	 
	Example of display in the upper left corner of the Asprova window 
	Note: If your copy of Asprova isn’t the latest, upgrade it to version 17.6.0.0 or later -those are the earliest releases that work with My Schedule. 

	 
	Step 5.1_02: Let's set up the Asprova side. 
	 
	Note: If "AsMySchedule.dll" is not found on the left side of the "Plug-in Information" menu: Make sure the plug-in file (AsMySchedule.dll) is in the same directory as the Asprova main unit. 


	5.2 Set up the integration! 
	Step 5.2_01: Let's set up the Asprova side. 
	Q_06: Asprova My Schedule operation items are not displayed...▼ 
	Asprova My Schedule Linkage Setting Window 
	 
	Note: If you have changed the host/IP address, port number, or password, please enter the changed information. 
	Q_07:I cannot connect to Asprova My Schedule in the linked settings...▼ 
	Destination Server Settings 
	Q_08: Why am I seeing the Free plan even though I purchased the Standard (Viewer) plan? ▼ 
	Display Period Setting 
	Note: Even in the case of unlimited, the display period must be set. 
	Screen Selection 
	Q_09: The screen I want to upload is grayed out, and I can't select it...▼ 
	Style Selection 

	Step 5.2_01: Let's set up the Asprova side. 
	Note: Uploading requires project administrator or server administrator privileges.  
	Browse and enter results Uploading is not allowed for accounts with "Permissions" or "View Only" privileges. 

	Step 5.2_03: View the uploaded schedule data in a web browser 
	Q_10: I get an error message about the number of simultaneous connections and cannot view the schedule…▼ 
	Resource Gantt chart displayed in My Schedule 
	Q_11: The selected style is not displayed...▼ 


	5.3 Download Achievements! 
	Step 5.3_01: Let's enter Achievements 
	The shaded line on the bar where results are entered 

	Step 5.3_02: Download the results! 
	Note: Downloads are available with the Free and Standard plans. They are not available under the Viewer plan. 
	Q_06: Asprova My Schedule operation items are not displayed...▼ 
	Asprova reflects the results 



	​​6. Share your scheduling data with My schedule! 
	6.1　Let’s create new users! 
	Step 6.1_01: Let's add a user! 
	*Refer to this section for Active Directory users 

	Step 6.1_02: Invite users! 


	 
	6.2　Set up user authentication using Active Directory! 
	 
	*If the Active Directory connection settings have not been completed,  
	the [Active Directory Login] button will not be displayed. 


	7. Update your My Schedule to the latest version! 
	Step 7_01 Update My Schedule module 
	Step 7_02 Update the plugin 
	 Note: that the number of bits in the plug-in must be aligned with the number of bits in Asprova. 

	Step 7_03 Re-upload data 
	Q_12: The old version is displayed in the web browser even after updating...▼ 


	8.Manually updating the My Schedule Module (Troubleshooting Guide) 
	Step 8_01 Download the My Schedule module! 
	 

	Step 8_02 Delete the existing Asprova WS version folder 
	Step 8_03 Copy the new files into the release folder 

	9. Q & A 
	Q_01: I would like to know the recommended operating environment. 
	 
	A_01: 
	Q_02: The My Schedule login screen does not appear in my web browser 
	 
	A_02: 
	Q_03: I cannot log in to My Schedule from a web browser. 
	 
	A_03: 
	Q_04: I want to move my e-protector to another machine 
	 
	A_04: 
	Q_05: I want to use e-protector with virtual machine technology 
	 
	A_05: 
	Q_06: Operation items in Asprova My Schedule are not displayed 
	 
	A_06: 
	Q_07: I cannot connect to the Asprova My Schedule linkage settings 
	 
	A_07: 
	Q_08:Why do I see a Free Plan even though I purchased a Standard (Viewer) Plan? 
	 
	A_08: 
	Q_09: The screen icon I want to upload is grayed out and I cannot select it 
	 
	A_09 
	Q_10: Cannot view the plan due to a concurrent connections error 
	 
	A_10: 
	Q_11: The selected style is not displayed 
	 
	A_11: 
	Q_12: Even after updating, the web browser shows an old version 
	 
	A_12: 



